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1. Importante

Questa guida all'uso elettronica € intesa

per chiunque usi il monitor Philips. Leggere
accuratamente questo manuale d'uso prima di
usare il monitor. Contiene informazioni e note
importanti sul funzionamento del monitor.

La garanzia Philips € valida a condizione che

il prodotto sia usato in modo corretto, in
conformita alle sue istruzioni operative, dietro
presentazione della fattura o dello scontrino
originale, indicante la data d'acquisto, il nome
del rivenditore, il modello ed il numero di
produzione del prodotto.

1.1 Manutenzione e precauzioni di
sicurezza

0 Awvisi

Lutilizzo di controlli, regolazioni o procedure
diverse da quelle specificate nelle presenti
istruzioni possono esporre al rischio di scariche
elettriche e pericoli elettrici e/o meccanici.

Leggere ed osservare le presenti istruzioni
durante il collegamento e I'utilizzo del monitor
del computer.

Funzionamento

¢ Tenere il monitor lontano dalla luce diretta
del sole, da luci molto luminose e da altre
fonti di calore. L'esposizione prolungata a
questo tipo di ambienti potrebbe causare
distorsioni nel colore e danni al monitor.

*  Rimuovere qualsiasi oggetto che potrebbe
cadere nei fori di ventilazione od ostacolare
il corretto raffreddamento delle parti
elettroniche del monitor.

* Non bloccare i fori di ventilazione sulle
coperture.

¢ Durante la collocazione del monitor
assicurarsi che il connettore e la presa
d'alimentazione siano facilmente accessibili.

*  Se si spegne il monitor scollegando il cavo
dalimentazione o il cavo DC, attendere
6 secondi prima di ricollegare il cavo

d'alimentazione o il cavo DC per il normale
funzionamento.

»  Utilizzare sempre il cavo d'alimentazione
approvato fomito da Philips. Se il cavo
d'alimentazione & assente, rivolgersi al
Centro Assistenza locale. (Fare riferimento
al Centro Informazioni Consumatori e
all’Assistenza Clienti)

* Non far subire al monitor forti vibrazioni o
impatti severi durante il funzionamento.

*  Non colpire né lasciare cadere il monitor
durante il funzionamento o il trasporto.

Manutenzione

* Per proteggere il monitor da possibili danni,
non esercitare pressione eccessiva sul
pannello LCD. Quando si sposta il monitor,
afferrare la struttura per sollevarlo; non
sollevare il monitor mettendo le mani o le
dita sul pannello LCD.

* Sesi prevede di non utilizzare il monitor
per lunghi periodi, scollegarlo dalla presa di
corrente.

*  Scollegare il monitor dalla presa di corrente
se € necessario pulirlo con un panno
leggermente umido. Lo schermo puod essere
asciugato con un panno asciutto quando
I'alimentazione € scollegata. Tuttavia, non
utilizzare solventi organici come alcool,
oppure liquidi a base di ammoniaca per
pulire il monitor.

*  Per evitare danni permanenti, non esporre
il monitor a polvere, pioggia, acqua o
eccessiva umidita.

* Se il monitor si bagna, asciugarlo con un
panno asciutto.

* Se sostanze estranee o acqua penetrano
nel monitor, disattivare immediatamente
I'alimentazione e scollegare il cavo
d'alimentazione. Quindi, rimuovere la
sostanza estranea oppure I'acqua ed inviare
immediatamente il monitor ad un Centro
Assistenza.

*  Non immagazzinare o usare il monitor LCD
in luoghi esposti a calore, luce diretta del
sole o freddo estremo.



* Per conservare prestazioni ottimali del
monitor e utilizzarlo per un periodo
prolungato, utilizzare il dispositivo in un
luogo caratterizzato dalle seguenti condizioni
ambientali:

* Temperatura: 0-40°C 32-95°F
* Umidita: 20-80% RH

Informazioni importanti sul Burn-in/immagini
“fantasma”.

+  Attivare sempre uno screen saver con
animazione quando si lascia il monitor
inattivo. Attivare sempre un'applicazione
d'aggiornamento periodico dello schermo se
il monitor visualizzera contenuti statici che
non cambiano. La visualizzazione ininterrotta
di immagini statiche per un lungo periodo
di tempo pud provocare sullo schermo il
fenomeno di "immagine residua" o "immagine
fantasma", noto anche come "burmn-in".
[I"Burn-in", la "sovrimpressione" o "immagine
fantasma" & un fenomeno ben noto alla
tecnologia dei pannelli LCD. Nella maggior
parte dei casi il fenomeno "burn-in", "immagine
residua” o "immagine fantasma" scompare
gradatamente nel tempo dopo che il monitor

¢ stato spento.
O Awiso

L.a mancata attivazione di uno screen saver, o di
una applicazione che aggiorna periodicamente
lo schermo, puo provocare gravi fenomeni di
“burn-in”, o “immagine residua” o “immagine
fantasma’” che non spariranno e che non
potranno essere corretti. | danni di cui sopra
non sono coperti dalla garanzia.

Assistenza

* La copertura del monitor deve essere
aperta esclusivamente da tecnici qualificati.

* In caso di necessita di qualsiasi documento
per la riparazione o l'integrazione,
contattare il proprio Centro Assistenza
locale. (Fare riferimento al capitolo "Centri
Informazioni Consumatori")

* Fare riferimento alla sezione "Specifiche
tecniche" per informazioni sul trasporto.

*  Non lasciare il monitor in un'automobile/
bagagliaio esposto alla luce diretta del sole.

& Nota

Consultare un tecnico dell'assistenza se |l
monitor non funziona normalmente oppure se
non si & sicuri di come procedere dopo avere
seguito le istruzioni di questo manuale .



1.2 Awvisi e legenda

La sezione che segue fornisce una descrizione
di alcuni simboli convenzionalmente usati in
questo documento.

Note, Attenzione e Avvisi

In questa guida, ci sono blocchi di testo
accompagnati da icone specifiche che sono
stampati in grassetto o corsivo. Questi blocchi
contengono note, awvisi alla cautela ed
allattenzione. Sono usati come segue:

& Nota

Questa icona indica informazioni e suggerimenti
importanti che aiutano a fare un uso migliore
del computer.

@ Attenzione

Questa icona indica informazioni che spiegano
come evitare la possibilita di danni al sistema o
la perdita di dati.

0 Awviso

Questa icona indica la possibilita di lesioni
personali e spiega come evitare il problema.

Alcuni awisi possono apparire in modo diverso
e potrebbero non essere accompagnati da
un'icona. In questi casi, la presentazione specifica
dell'awiso € prescritta dalla relativa autorita
competente.

1.3 Smaltimento del prodotto e dei
materiali d'imballaggio

Apparecchi elettrici ed elettronici da smaltire
- WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2012/19/EU governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.
Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.



Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation innational take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and
related packaging material) in accordance with
all Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page


http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page

H Installazione della base

1. Collocare il monitor; a faccia in gid, su una
superficie liscia, prestando attenzione a non
graffiare o danneggiare lo schermo.

2. Impostazione del monitor

2.1 Installazione _
2. Attaccare/far scorrere il supporto nel

E Contenuti della confezione monitor finché scatta in posizione.

3. Tenere la base del monitor con entrambe
le mani ed inserire con fermezza la base
nel supporto.

*In base al Paese



H Collegamento al PC
223V5LSB/223V5LSW/223V5LSB2
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@ Ingresso potenza AC

© Ingresso VGA

© Ingresso DVI-D (disponibile per modelli
selezionati)

© Sistema antifurto Kensington

223V5LHSB/223V5LHSW/223V5LHSB2

PHILIPS

@ Ingresso potenza AC

© IngressoVGA

© Ingresso HDMI

© Uscita audio HDMI

(disponibile per modelli selezionati)
© Sistema antifurto Kensington

Collegamento al PC

1. Collegare saldamente il cavo
d'alimentazione sul retro del monitor.

2. Spegnere il computer e staccare il cavo
d'alimentazione.

3. Collegare il cavo segnale del monitor al
connettore video sul retro del computer:

4. Collegare i cavi d'alimentazione del
computer e del monitor ad una presa di
corrente nelle vicinanze.

5. Accendere il computer ed il monitor. Se sul
monitor appare un'immagine, l'installazione
€ riuscita.

2.2 Funzionamento del monitor

Bl Descrizione del pannello frontale del
prodotto

223V5L:
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®  |Accendere e spegnere il monitor.

Accedere al menu OSD.
E&)/0K |Confermare la regolazione
dellOSD.

< Per tornare al livello precedente
del menu OSD.

Regolare il livello di luminosita.

A 'V [Regolare il menu OSD.

[l |Passa alla visualizzazione 4:3.

© 60660 © O
o

Regolare automaticamente |l
AUTO monitor.




Bl Descrizione del menu OSD

Che cos’¢ il menu OSD (On-Screen Display)?

['menu OSD (On-Screen Display) € una
funzione di tutti i monitor LCD Philips.
Consente all'utente di regolare le prestazioni
dello schermo o di selezionare le funzioni del
monitor direttamente tramite una finestra

di istruzioni a video. Di seguito & mostrata
un'illustrazione della semplice interfaccia OSD:

223V5LHSB/223V5LHSW/223V5LHSB2:

223V5LSB/223V5LSW/223V5LSB2 (per
modello 1A):

LEERRRRND 1o
LERRREELLE s

Istruzioni semplici e di base sui tasti di
controllo

Nel menu OSD mostrato in precedenza,
premere i tasti ¥ A sul pannello frontale del

monitor per spostare il cursore e premere il
tasto OK per confermare la scelta o la modifica.

Il menu OSD

Di seguito c'é una descrizione generale della
struttura del menu OSD. Questa puo essere
utilizzata come riferimento quando in seguito si

lavorera sulle diverse regolazioni.

Main menu Sub menu

VGA
Input E DVI (available for selective models)
HDMI (available for selective models)

Picture Format -

. Brightness —
Picture 8

Contrast —

SmartContrast —_

Over scan —_

Wide Screen, 4:3
0~100

0~100

On, Off

On, Off

(available for selective models)

Volume —
Audio E y
ute -

(available for selective models)

Color Temperature ——
Color E sRGB

0~100
On, Off

6500K, 9300K

User Define Red: 0~100
E Green: 0~100
Blue: 0~100
Language —— English,Espafol,Francais,Deutsch,ltaliano,

Portugués,Pycckuit, & f A1 32, Tiirkge,
Nederlands, Svenska, Suomi, Polski, Cestina

8201, BAFE, Maryar, Ykpaicbka,

Portugués do Brazil EN\nVIKY| (TpoaIpeTIKAQ),

i X ()

r— Horizontal —
— Vertical —
OSD Settings
[ Transparency -

— OSD Time Out -

— Auto
Setup
— H. Position

— V. Position

[ Phase

— Clock

—— Resolution Notification
— Reset

L Information

0~100

0~100

Off, 1,2, 3,4

5s, 10s, 20s, 30s, 60s

— 0~100
— 0~100
— 0~100
— 0~100
— On, Off
— Yes, No



El Notifica di risoluzione

Questo monitor € progettato per rendere

le prestazioni ottimali alla sua risoluzione
originaria di 1920 x 1080 @ 60 Hz. Quando il
monitor & impostato su una risoluzione diversa,
allaccensione ¢ visualizzato un awviso: Usare
1920 x 1080 @ 60 Hz per ottenere i migliori
risultati.

La visualizzazione dell'avwviso pud essere
disattivata dal menu Configurazione del menu
OSD (On Screen Display).

B Funzioni fisiche

Inclinazione

L

2.3 Rimozione del supporto e della
base

El Rimozione della base

Prima di iniziare a smontare la base del monitor,
osservare le istruzioni che seguono per evitare
eventuali danni o lesioni.

1. Collocare il monitor; a faccia in git, su una
superficie liscia, prestando attenzione a non
graffiare o danneggiare lo schermo.

2. Premere i fermagli per staccare la base dal
supporto.

3. Premere il tasto di rilascio per staccare la
colonna della base.




& Nota

Questo monitor accetta un'interfaccia di

montaggio compatibile VESA 100 mm x 100
mm.

PHIURS

109mm

100mm




dotato di attraenti icone animate & pronto
per migliorare la tua esperienza con i monitor
Philips!

3. Informazioni sul prodotto

3.1 SmartContrast El Installazione

) *  Attenersi alle istruzioni e completare
N Che cos'e! linstallazione.
Tecnologia unica che analizza dinamicamente

i contenuti visualizzati ed ottimizza
automaticamente il rapporto di contrasto del
LCD per la massima chiarezza e piacevolezza
visiva, aumentando l'illuminazione per
immagini pit chiare, luminose e nitide oppure
diminuendola per la visualizzazione di immagini
chiare su sfondi scuri.

* L'awvio si esegue ad installazione terminata.

*  Se sivuole awviare l'applicazione in un
secondo tempo, fare clic sul collegamento del
desktop o nella barra degli strumenti.

E1 Perché ne ho bisogno?

Vuoi la chiarezza ed il comfort visivo migliore
per ogni tipo di contenuto. SmartContrast
controlla dinamicamente il contrasto e regola
lilluminazione per immagini e videogiochi chiari,
nitidi e luminosi, oppure per visualizzare testo
chiaro e leggibile per i lavori d'ufficio. Riducendo
il consumo energetico del monitor, si risparmia
sui costi e si allunga la durata del monitor.

El Come funziona? Procedura Wizard (guidata) primo avvio

* La prima volta, dopo l'installazione di
SmartControl Lite, si passera automaticamente
alla procedura Wizard (guidata) primo awvio.

Quando si attiva SmartContrast i contenuti
visualizzati saranno analizzati in tempo reale
per regolare i colori e controllare I'intensita

dell'illuminazione. Questa funzione migliora il * che guidera passo a passo nel corso delle
contrasto in modo dinamico per una grandiosa PrOC?dee di regolazione delle prestazioni del
esperienza d'intrattenimento quando si monitor.

guardano video o mentre si gioca. *  Perawiare la procedura guidata in un secondo

tempo, si puo andare al menu Plug-in.

o n * Usando il pannello Standard si possono
32 PhI|IpS SmartControl Lite regolare altre opzioni senza ausilio della

Il nuovo software SmartControl Lite Phillips procedura guidata.
permette di controllare il monitor usando

una semplice interfaccia grafica. Le regolazioni

complicate appartengono al passato; questo

software facile da usare guida durante le

procedure per regolare con precisione la

calibratura del colore, Fase/Clock, punto di

bianco RGB, eccetera.

Dotato della tecnologia pit avanzata in materia
di algoritmi core per velocita d'elaborazione e
risposta, questo software compatibile Windows

10



E3 Inizio con il pannello Standard:

Menu Adjust (Regolazione):

* | menu Adjust (Regolazione) permette di
regolare: Brightness (Luminosita), Contrast
(Contrasto), Focus (Fuoco), Position
(Posizione) e Resolution (Risoluzione).

*  Seguire le istruzioni ed eseguire la
regolazione.

* Lavoce Cancel (Annulla) chiede all'utente
se vuole annullare l'installazione.

11



Menu Color (Colore):

[ menu Color (Colore) permette di
regolare: RGB, Black Level (Livello di
nero), White Point (Punto bianco) e Color
Calibration (Calibratura colore).

Seguire le istruzioni ed eseguire la
regolazione.
Fare riferimento alla tabella che segue per

informazioni dettagliate sulle voci dei menu
secondari in base all'ingresso.

Esempio di Color Calibration (Calibratura
colore).

12



1. "Show Me" (Mostrami) awvia il Tutorial della
calibratura colore.

2. Start (Awvia) — Awvia la sequenza di 6 fasi
della calibratura colore.

3. QuickView (Visione rapida) carica le
immagini prima/dopo.

4. Fare clic sul tasto Cancel (Annulla) per
tornare al pannello principale Color
(Colore).

5. Enable color calibration (Abilita calibratura
colore) - Per impostazione predefinita
questa opzione ¢ attivata. Se ¢ deselezionata,
la calibratura colore non ha luogo ed i tasti
Awvia e Visione rapida sono disabilitati.

6. La schermata della calibratura deve avere le
informazioni dei diritti esclusivi.

Prima schermata della calibratura colore:

[ ]

» |ltasto Previous (Precedente) e disabilitato
fino alla seconda schermata colore.

* ll'tasto Next (Avanti) va alla schermata
successiva (ci sono 6 schermate).

* |l tasto Avanti dell'ultima schermata porta al
pannello File > Presets (Preselezioni).

* ll'tasto Cancel (Annulla) chiude l'interfaccia
e torna alla schermata Plug-in.

Options > Preferences (Opzioni > Preferenze)
- Sara attivo solo quando si seleziona
Preferences (Preferenze) dal menu a discesa
Options (Opzioni). Sugli schermi non supportati,
con capacita DDC/CI, saranno disponibili solo
le schede Help (Guida) e Options (Opzioni).

* Visualizza le impostazioni correnti delle
preferenze.

* Una casella selezionata abilita la funzione.
La casella puo essere selezionata e
deselezionata.

* Lavoce Enable Context Menu (Abilita
menu contestuale) sul desktop &
selezionata (attivata) per impostazione
predefinita. Enable Context Menu (Abilita
menu contestuale) visualizza le opzioni
di SmartControl Lite di Select Presets
(Selezione predefiniti) e Tune Display
(Regola schermo) del menu contestuale
del desktop (clic tasto destro del
mouse). Disabled (Disabilitato) rimuove
SmartControl Lite dal menu contestuale.

* Lavoce Enable Task Tray (Abilita icona
area di notifica) € selezionata (attivata) per
impostazione predefinita. Enable Context
Menu (Abilita menu contestuale) mostra il
menu dell'area di notifica di SmartControl
Lite. Facendo clic col tasto destro del
mouse sull'icona nell'area di notifica, &
visualizzato un menu di opzioni con le voci
Help (Guida), Technical Support (Supporto
tecnico), Check for Update (Controlla
aggiornamenti), About (Informazioni) ed
Exit (Esci). Quando la voce Enable task



tray menu (Abilita menu area di notifica) Options > Audio (Opzioni > Audio) — Sara
¢ disabilitata, I'icona dell'area di notifica attivo solo quando si seleziona Audio dal menu
visualizza solo EXIT (ESCI). a discesa Options (Opzioni).

* Lavoce Run at Startup (Esegui all'avwio)
é selezionata (attivata) per impostazione
predefinita. Quando disabilitato,
SmartControl Lite non si avviera all'awvio,
né sara nell'area di notifica. Il solo modo
per awiare SmartControl Lite & usare il
collegamento sul desktop oppure il file
del programma. Tutte le impostazioni
configurate per essere eseguite all'avvio non
si caricheranno quando questa casella €
deselezionata (disabilitata).

* Enable transparency mode (Abilita
trasparenza) (Windows 7/8, Vista, XP).
L'impostazione predefinita & 0% Opaco.

Sugli schermi non supportati, con capacita
DDC/CI, saranno disponibili solo le schede
Help (Guida) e Options (Opzioni).

Options > Input (Opzioni > Ingresso) — Sara
attivo solo quando si seleziona Input (Ingresso)
dal menu a discesa Options (Opzioni). Sugli
schermi non supportati, con capacita DDC/CI,
saranno disponibili solo le schede Help (Guida)
e Options (Opzioni). Tutte le atre schede di

SmartControl Lite non sono disponibili. Help > User Manual (Guida > Manuale d'uso)

— Sara attivo solo quando si seleziona User
Manual (Manuale d'uso) dal menu a discesa
Help (Guida). Sugli schermi non supportati, con
capacita DDC/CI, saranno disponibili solo le
schede Help (Guida) e Options (Opzioni).

*  Visualizza il pannello Istruzioni Source
(origine) e le impostazioni correnti
dell'origine dell'ingresso.

*  Su schermi con un solo ingresso, questo
pannello non sara visibile.

14



Help > Version (Guida > Versione) - Sara
attivo solo quando si seleziona Version
(Versione) dal menu a discesa Help (Guida).
Sugli schermi non supportati, con capacita
DDC/CI, saranno disponibili solo le schede
Help (Guida) e Options (Opzioni).

Menu contestuale sensibile

Il Context Sensitive Menu (menu contestuale
sensibile) ¢ abilitato per impostazione
predefinita. Se la voce Enable Context Menu
(Abilita menu contestuale) é stata selezionata
nel pannello Options > Preferences (Opzioni >

Preferenze), il menu sara visibile.

Menu contestuate ha tre voci:

¢ SmartControl Lite - Quando selezionato,
€ visualizzata la schermata About
(Informazioni) sullo schermo.

*  Select Preset (Selezione predefiniti) -
Fornisce un menu gerarchico di impostazioni
predefinite salvate per 'uso immediato.
Un segno di spunta mostra l'impostazione
predefinita correntemente selezionata. Dal
menu a discesa puod essere richiamata la
voce Valori predefiniti.

* Tune Display (Regola schermo) - Apre il
pannello di controllo di SmartControl Lite.

Menu area di notifica abilitato

I menu dell'area di notifica puo essere
visualizzato facendo clic col tasto destro del
mouse sull'icona SmartControl Lite nell'area
di notifica. Il clic col tasto sinistro del mouse
awviera l'applicazione.

Larea di notifica ha cinque voci:

* Help (Guida) - Accesso al User Manual
(Manuale d'uso): Apre il file del User
Manual (Manuale d'uso) usando il browser
predefinito.

* Technical Support (Supporto tecnico) -
Visualizza la pagina del Supporto tecnico.

*  Check for Update (Controlla aggiornamenti)
- Porta alla pagina PDI Landing e verifica la
versione dell'utente con quella pit recente
disponibile.

* About (Informazioni) - Visualizza
informazioni dettagliate di riferimento:
versione del prodotto, informazioni sulla
pubblicazione e nome del prodotto.

»  Exit (Esci) - Chiude SmartControl Lite

Per eseguire di nuovo SmartControl Lite
selezionare SmartControl Lite dal menu
Program (Programmi), fare doppio clic sull'icona
del desktop, oppure riawviare il sistema.

PHILIPS



Menu area di notifica disabilitato

Quando l'area di notifica € disabilitata nella
cartella delle preferenze, € disponibile solo la
selezione EXIT (ESCI). Per rimuovere in modo
completo SmartControl Lite dall'area di notifica,
disabilitare la voce Run at Startup (Esegui
all'awio) in Options (Opzioni) > Preferences
(Preferenze).

& Nota

Tutte le illustrazioni di questa sezione sono
solo per riferimento. La versione del software
SmartControl puo essere modificata senza
preawiso. Controllare sempre il sito Portrait
ufficiale www.portrait.com/dtune/phl/enu/index
per scaricare |'ultima versione del software
SmartControl.
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4. Specifiche tecniche

Immagine/Schermo

Tipo di pannello LCD LCD TFT
llluminazione LED

Dimensioni del pannello 21,5" L (54,6cm)
Rapporto proporzioni 16:9

Dimensioni pixel

0,248 x 0,248 mm

Luminosita 250 cd/m? or 200 cd/m?
SmartContrast 10,000,000:1

Rapporto di contrasto (tipico) 1000:1 or 600:1 for 200 nit
Tempo di risposta (tipico) 5ms

Risoluzione ottimale 1920 x 1080 @ 60Hz

Angolo di visuale

170° (H) / 160° (V) @ C/R > 10
or 90° (H) / 65° (V) @ C/R > 10 for 200 nit

Colori dello schermo

16,7 milioni

Frequenza d'aggiornamento
verticale

56Hz - 76Hz

Frequenza orizzontale

30kHz - 83kHz

sRGB
Connettivita
Ingresso segnale

S|

223V5LSB/223V5LSW/223V5LSB2: VGA (analogico)
DVI(digitale HDCP) (optional)

223V5LHSB/223V5LHSW/223V5LHSB2: VGA (analogico)
,HDMl(digitale, HDCP)

Ingresso/uscita audio

Uscita audio HDMI ( 223V5LHSB/223V5LHSW)

Segnale d'ingresso
Utilita
Funzioni utili

Sincronia separata, Sync on Green

AUTO/Y  ED/A 0-/<4 /0K 0)

Lingue OSD

Inglese, Tedesco, Spagnolo, Francese, ltaliano, Ungherese,
Olandese, Portoghese, Portoghese Brasiliano, Polacco,
Russo, Svedese, Finlandese, Turco, Ceco, Ucraino, Cinese
semplificato, Giapponese, Coreano, Greco(optional), Cinese
tradizionale(optional)

Altre funzioni utili

Sistema antifurto Kensington

Compatibilita Plug & Play

DDC/CI, sRGB, Windows 7/8/Vista/XP, Mac OSX, Linux

Montaggio VESA
Base
Inclinazione

100100 mm

-5/+20

223V5LHSB/223V5LHSW/223V5LHSB2:

Alimentazione

Acceso

19.66 W (tip.), 23.76 W (max.)for 223V5LHSB/223V5LHSW  or
21.63W (tip.), 25.63W(max.)for 223V5LHSB2

Sospensione (Standby)

0,5W
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Spento

05W

Indicatore di alimentazione

Modalita accensione: Bianco, Standby/Sospensione: Bianco
(lampeggiante)

Alimentazione

Integrato, 100-240VAC, 50-60Hz

Alimentazione
Acceso

223V5LSB/223V5LSW/223V5LSB2:

18,6W (tip.),22,57 W (max.) for 223V5LSB/ 223V5LSW
or 17,07W (tip.),20,26 W (max.) for 223V5LSB2

Sospensione (Standby)

0,5W

Spento

05W

Indicatore di alimentazione

Modalita accensione: Bianco, Standby/Sospensione: Bianco
(lampeggiante)

Alimentazione

Integrato, 100-240VAC, 50-60Hz

Dimensioni
Prodotto con base (LxHxP)

503 x 376 x 213 mm

Prodotto senza base (LxHxP)

Prodotto con base

503 x 316 x 50 mm

2,605kg

Prodotto senza base

2,304kg

Condizioni operative
Portata temperatura (operativa)

Da 0° Ca40° C

Portata temperatura
(non operativa)

Da -20° Ca 60° C

Conformita e standard

Approvazioni a norma di legge

Umidita relativa 20% a 80%

MTBF 30.000 ore

ROHS Sl

EPEAT Silver (www.epeat.net)
Confezione 100% riciclabile
Energy Star Si

CE Mark, FCC Class B, EAC, SEMKO, BSMI, cETLus,
1S09241-307, TCO Certified , INMETRO(Only for selective models)

Colore Nero/Bianco
Finitura Superficie

& Nota

La certificazione EPEAT Gold o

RN

Silver & valida solo dove Philips registra il prodotto. Visitare il sito

www.epeat.net per conoscere lo stati della registrazione nel proprio paese.

N

Questi dati sono soggetti a cambiamenti senza preavviso. Andare all'indirizzo www.philips.com/

support per scaricare la versione pit recente del foglio informativo.
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http://www.support.philips.com/support/catalog_selector.jsp
http://www.support.philips.com/support/catalog_selector.jsp

4.1 Risoluzione e Modalita
predefinite

H Risoluzione massima
1920 x 1080 @ 60 Hz (ingresso analogico)
1920 x 1080 @ 60 Hz (ingresso digitale)

E Risoluzione raccomandata
1920 x 1080 @ 60 Hz (ingresso digitale)

Frequenza Resolution Frequenza

orizzontale (kHz) (Risoluzione)  verticale (Hz)
3147 720 x 400 70,09
3147 640 x 480 59,94
35,00 640 x 480 66,67
37,86 640 x 480 72,81
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03
44,77 1280 x 720 59,86
63,89 1280 x 1024 60,02
79,98 1280 x 1024 75,03
5594 1440 x 900 59,89
70,64 1440 x 900 7498
65,29 1680 x 1050 59,95
67,50 1920 x 1080 60,00

& Nota

Notare che lo schermo funziona meglio alla
risoluzione originale di 1920 x 1080 @ 60Hz.
Attenersi a questa raccomandazione per
ottenere la qualita migliore di visualizzazione.
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5. Risparmio energetico

Se la scheda video o il software installato sul
PC & conforme agli standard DPM VESA, il
monitor puo ridurre automaticamente il suo
consumo energetico quando non € in uso.
Quando ¢ rilevato I'input dalla tastiera, dal
mouse o altri dispositivi, il monitor si "risveglia"
automaticamente. La tabella che segue mostra il
consumo energetico e le segnalazioni di questa
funzione automatica di risparmio energetico:

223V5LHSB/223V5LHSW/223V5LHSB2:

Definizione del risparmio energetico

Modalita i
odalita Video S\Incroma Smcv.‘oma Potenza usata [ Colore del LED
VESA orizzontale [ verticale
19.66 W (typ.)
for 223V5LHSB
Attiva ATTIVO Si Si 1223V5LHSW Bianco
or 21.63W (typ)
for 223V5LHSB2
.
Sospensione [DISATTIVO| ~ No No 05W (tip) anco
(lampeggiante)
Spegnimento |DISATTIVO - - 0,5W (tip.) DISATTIVO

223V5LSB/223V5LSW/223V5LSB2:

Definizione del risparmio energetico

Modalta Video S\‘ncmma Smcfoma Potenza usata | Colore del LED
VESA orizzontale | verticale
18,6W (tip.) for
223V5LSB
Attiva ATTIVO Si Si /223V5LSW Bianco
or 17,07W (tip.)
for 223V5LSB2
Sospensione [DISATTIVO| ~ No No 05W (tip) CEnEs
(lampeggiante)
Spegnimento |DISATTIVO - - 0,5W (tip.) DISATTIVO

La configurazione che segue € usata per
misurare il consumo energetico di questo
monitor.

* Risoluzione originale: 1920 x 1080
Contrasto: 50%
Luminosita: 250 nit or 200 nit

Temperatura colore: 6500k con modello
tutto bianco

e Nota

Questi dati sono soggetti a cambiamenti senza
preawviso.



6. Informazioni legali

Lead-free Product

Lead free display promotes

@ environmentally sound recovery
ey and disposal of waste from electrical

and electronic equipment. Toxic

substances like Lead has been eliminated

and compliance with European community's

stringent RoHs directive mandating restrictions

on hazardous substances in electrical and

electronic equipment have been adhered to

in order to make Philips monitors safe to use

throughout its life cycle.

Congratulations!

This product is TCO Certified - for Sustainable
T

TCO Certified is an international
third party sustainability certification

for IT products. TCO Certified.
ensures that the manufacture, use and recycling
of IT products reflect environmental, social and
economic responsibility. Every TCO Certified
product model is verified by an accredited
independent test laboratory.

This product has been verified to meet all the
criteria in TCO Certified, including:

» Corporate Social Responsibility
Socially responsible production - working
conditions and labor law in manufacturing
country

» Energy Efficiency
Energy efficiency of product and power
supply. Energy Star compliant, where
applicable

*  Environmental Management System
Manufacturer must be certified according
to either ISO 14001 or EMAS

*  Minimization of Hazardous Substances
Limits on cadmium, mercury, lead
& hexavalent chromium including
requirements for mercury-free products,
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halogenated substances and hazardous
flame retardants

*  Design for Recycling
Coding of plastics for easy recycling. Limit
on the number of different plastics used.

*  Product Lifetime, Product Take Back
Minimum one-year product warranty.
Minimum three-year availability of spare
parts. Product takeback

» Packaging
Limits on hazardous substances in product
packaging. Packaging prepared for recycling

*  Ergonomic, User-centered design
Visual ergonomics in products with a
display. Adjustability for user comfort
(displays, headsets) Acoustic performance
— protection against sound spikes
(headsets) and fan noise (projectors,
computers) Ergonomically designed
keyboard (notebooks)

* Electrical Safety, minimal electro-magnetic
Emissions Third Party Testing
All certified product models have been
tested in an independent, accredited
laboratory.

A detailed criteria set is available for download
at www.tcodevelopment.com, where you can
also find a searchable database of all TCO
Certified IT products.

TCO Development, the organization behind
TCO Certified, has been an international
driver in the field of Sustainable [T for 20 years.
Criteria in TCO Certified are developed in
collaboration with scientists, experts, users

and manufacturers. Organizations around the
world rely on TCO Certified as a tool to help
them reach their sustainable IT goals. We are
owned by TCO, a non-profit organization
representing office workers. TCO Development
is headquartered in Stockholm, Sweden, with
regional presence in North America and Asia.

For more information, please visit
www.tcodevelopment.com



[T}

CERTIFIED

Technology for you and the planet

(Only for selective models)

EPEAT

(www.epeat.net)

> The EPEAT (Electronic
Q@ Product Environmental
<
A Assessment Tool) program
evaluates computer
desktops, laptops, and monitors based on
51 environmental criteria developed through
an extensive stakeholder consensus process

supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the

design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact

of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S

requirement that all registered products meet

ENERGY STAR'’s energy efficiency specifications,

means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

EN60950-1:2006+A11:2009+A1:20
10+A12:2011 (Safety requirement of
Information Technology Equipment).
EN55022:2010 (Radio Disturbance
requirement of Information Technology
Equipment).

EN55024:2010 (Immunity requirement of
Information Technology Equipment).
EN61000-3-2:2006 +A1:2009+A2:2009
(Limits for Harmonic Current Emission).
EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

2006/95/EC (Low Voltage Directive).
2004/108/EC (EMC Directive).
2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive

for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following
standards

1S09241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

GS EK1-2000:2011 (GS mark requirement).

prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(www.energystar.gov)

h As an ENERGY STAR® Partner, we
have determined that this product
refd meets the ENERGY STAR®
guidelines for energy efficiency.
& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

© This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.
This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

+ Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

» Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

1

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following
two conditions: (1) this device may not cause
harmful interference, and (2) this device must
accept any interference received, including
interference that may cause undesired
operation.

Commission Federale de la Communication
(FCC Declaration)

€ Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de I'article
15 Des regles de la FCC. Ces limites sont
congues de fagon a fourir une protection
raisonnable contre les interférences nuisibles
dans le cadre d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences


www.energystar.gov

nuisibles aux communications radio.
Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre |'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a l'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU

REGLEMENT SUR LE MATERIEL BROUILLEUR

DU CANADA.
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EN 55022 Compliance (Czech Republic Only)

This dewice belongs to catagory B dsvices as described in EN 55022, unless it is spacti-
cally stated that it is a Class A devics on the spectication labal. The following appiies to
devicss in Class 4 of EN 55022 (radius of protection up to 30 meters). The user of the
devics i3 obliged to taks all staps necessary to remove sources of intarference 1o tels-
communication or sther devicss

Pokud neni na fypovém Bthu potatie uvedana, #6 spadé do do tidy A podie EN 55022,
spaca automaticky o thidy B podle EN 55022, Pro zafizen! zafazend do thidy A (chranné
pésma 30m) podie EN 550222 plati nésledufic. Dojde-li k ruflan! telskomunikatich nebo
finjich zafizani je uZivatal povinnen provist takova opatfgn, aby rufeni odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so
on) should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/
T-42107 and PN-89/E-06251.
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILG/ANGELIGE.

Paikka/llmankierto

VAROITUS:

SIOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
HAZHENERZIEE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schaden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Riickwand des Gerdtes befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Stérstrahlern nach Anlage
a5 Abs. 4 der Rontgenverordnung erfilit
sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhéhte Augenbelastung bei zu
geringem Zeichenkontrast wéren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betragt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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EU Energy Label

The European Energy Label informs you on
the energy efficiency class of this product.
The greener the energy efficiency class of this
product is the lower the energy it consumes.

On the label, you can find the energy efficiency
class, the average power consumption of

this product in use and the average energy
consumption for 1 year.

SNote
The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.



7. Assistenza Clienti e
Garanzia

7.1 Criteri di valutazione dei pixel
difettosi dei monitor a schermo
piatto Philips

La Philips si impegna a consegnare prodotti della
piU alta qualita. Utilizziamo alcuni dei processi
di produzione pit avanzati nell'industria e delle
rigorose procedure di controllo della qualita.
Tuttavia i difetti dei pixel o dei pixel secondari
dei pannelli LCD TFT usati nei monitor a
schermo piatto a volte sono inevitabili. Nessun
produttore ¢ in grado di garantire che tutti

i pannelli siano privi di difetti dei pixel, ma la
Philips garantisce che qualsiasi monitor con un
numero inaccettabile di difetti sara riparato
oppure sostituito sotto garanzia. Questa nota
spiega i diversi tipi di difetti dei pixel e definisce
i livelli accettabili di difetto per ogni tipo. Per
avere diritto alla riparazione o sostituzione

in garanzia, il numero di pixel difettosi di un
pannello LCD TFT deve eccedere questi

livelli accettabili. Ad esempio: non pit dello
0,0004% dei pixel secondari di un monitor puo
essere difettoso. Inoltre, Philips stabilisce degli
standard di qualita ancora piu alti per alcuni

tipi o combinazioni di difetti dei pixel che sono
piU evidenti di altri. Questi criteri di valutazione
sono validi in tutto il mondo.

secondari secondari secondari

vy
pixel

Pixel e pixel secondari

Un pixel, o elemento dell'immagine, € composto
di tre pixel secondari nei tre colori primari
rosso, verde e blu. Molti pixel messi insieme
formano un'immagine. Quando tutti i pixel
secondari di un pixel sono illuminati, i tre pixel
secondari colorati appaiono insieme come un
singolo pixel bianco. Quando sono tutti spenti,

i tre pixel secondari colorati appaiono insieme

come un pixel nero. Altre combinazioni di pixel
illuminati o spenti appaiono come singoli pixel
di altri colori.

Tipi di difetti dei pixel

| difetti dei pixel e dei pixel secondari appaiono
sullo schermo in modi diversi. Esistono due
categorie di difetti dei pixel e diversi tipi di
difetti dei pixel secondari all'interno di ogni
categoria.

Punti luminosi

Questi difetti appaiono come pixel o pixel
secondari che sono sempre accesi oppure
‘attivi'. Un punto luminoso € un pixel secondario
che risalta sullo schermo quando il monitor
visualizza un motivo scuro. Ci sono vari tipi di
punti luminosi:

Un pixel secondario rosso, verde o blu
illuminato

I C

Due pixel secondari adiacenti illuminati:
- Rosso + Blu =Viola

- Rosso +Verde = Giallo

- Verde + Blu = Ciano (blu chiaro)




Tre pixel secondari adiacenti illuminati (un pixel
bianco).

& Nota

Un punto luminoso rosso o blu deve essere
oltre il 50 percento piti luminoso dei punti
adiacenti mentre un punto luminoso verde ¢ il
30 percento pit luminoso dei punti adiacenti.

Punti neri

Compaiono come pixel o pixel secondari
sempre spenti o 'inattivi'. Un punto nero e
un pixel secondario che risalta sullo schermo
quando il monitor visualizza un motivo chiaro.

Ci sono vari tipi di punti neri:

Prossimita dei difetti dei pixel

Poiché i difetti dei pixel e dei pixel secondari
dello stesso tipo che si trovano vicini fra loro
sono piu evidenti, la Philips specifica anche le
tolleranze per la prossimita dei difetti dei pixel.

Tolleranze dei difetti dei pixel

Per avere diritto alla riparazione o sostituzione
in garanzia a causa di pixel difettosi, un pannello
LCDTFT di un monitor a schermo piatto
Philips deve avere una quantita di pixel o pixel
secondari difettosi che eccede le tolleranze
elencate nelle tabelle che seguono.

PUNTI LUMINOSI LIVELLO ACCETTABILE
1 pixel secondario acceso 3

2 pixel secondari adiacenti accesi 1

3 pixel secondari adiacenti accesi (un pixel bianco) 0

Distanza tra due punti luminosi* >15mm

Totale di punti bianchi di tutti i tipi 3

PUNTI NERI LIVELLO ACCETTABILE
1 pixel secondario scuri 5 0 meno

2 pixel secondari scuri adiacenti 2 0 meno

3 pixel secondari scuri adiacenti 0

Distanza tra due punti neri* >15mm

Totale di punti neri di tutti i tipi 5 0 meno

TOTALE PUNTI DIFETTOSI

LIVELLO ACCETTABILE

Totale di punti bianchi o punti neri di tutti i tipi

5 0 meno

& Nota

1. 1 o 2 pixel secondari adiacenti = 1 punto difettoso
2. Questo monitor ¢ conforme 1SO 9241-307. (ISO 9241-307: Requisiti ergonomici, metodi d'analisi
e di verifica della conformita per i dispositivi elettronici di visualizzazione)

3. La norma 1SO9241-307 succede alla norma nota come 1SO13406, che e stata emendata
dall'lnternational Organisation for Standardisation (ISO) il 13 Novembre 2008.
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7.2 Assistenza Clienti e Garanzia

Per informazioni sulla copertura della garanzia e sui requisiti aggiuntivi di assistenza validi per la vostra
area, visitare il sito web www.philips.com/support. E inoltre possibile contattare il numero del vostro
Philips Customer Care Center piu vicino elencato in basso.

Informazioni di contatto per zona del’lEUROPA OCCIDENTALE:

Paese CSP Numero verde Prezzo Orario d’apertura

Austria RTS +43 0810 000206 €007 Mon to Fri: 9am - 6pm
Belgium Ecare +32 078 250851 €0.06 Mon to Fri: 9am - 6pm
Cyprus Alman 800 92 256 Free of charge | Mon to Fri: 9am - 6pm
Denmark Infocare +45 3525 8761 Local call tariff | Mon to Fri: 9am - 6pm
Finland Infocare +358 09 2290 1908 | Local call tariff [ Mon to Fri: 9am - 6pm
France Mainteq +33 082161 1658 €0.09 Mon to Fri: 9am - 6pm
Germany RTS +49 01803 386 853  |€0.09 Mon to Fri: 9am - 6pm
Greece Alman +30 00800 3122 1223 | Free of charge [ Mon to Fri: 9am - 6pm
Ireland Celestica +353 01 601 1161 Local call tariff [ Mon to Fri: 8am - 5pm
Italy Anovo ltaly [ +39 840 320 041 €0.08 Mon to Fri: 9am - 6pm
Luxembourg Ecare +352 26 84 30 00 Local call tariff | Mon to Fri: 9am - 6pm
Netherlands Ecare +31 0900 0400 063 € 0.10 Mon to Fri: 9am - 6pm
Norway Infocare +47 2270 8250 Local call tariff | Mon to Fri: 9am - 6pm
Poland MSI +48 0223491505 Local call tariff | Mon to Fri: 9am - 6pm
Portugal Mainteq 800 780 902 Free of charge | Mon to Fri: 8am - 5pm
Spain Mainteq +34 902 888 785 €0.10 Mon to Fri: 9am - 6pm
Sweden Infocare +46 08 632 0016 Local call tariff [ Mon to Fri: 9am - 6pm
Switzerland ANOVO CH [ +41 02 2310 2116 Local call tariff | Mon to Fri: 9am - 6pm
United Kingdom | Celestica +44 0207 949 0069 Local call tariff | Mon to Fri: 8am - 5pm

Informazioni di contatto per la Cina:
Numero assistenza clienti

4008 800 008

Call center

PCCW Limited

Paese

China

Informazioni di contatto per il NORD AMERICA:

Paese Call center Numero assistenza clienti
USA EPl-e-center (877) 835-1838
Canada EPl-e-center (800) 479-6696




Informazioni di contatto per zona del’lEUROPA ORIENTALE E CENTRALE:

Paese Call center CSP Numero assistenza clienti
+37517 217 3386
Belarus NA IBA +37517 217 3389
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA MR Service Ltd +385 (01) 640 1111
Czech Rep. NA Asupport 420 272 188 300
+372 6519900(General)
Estonia NA FUJITSU +372 6519972 (workshop)
Georgia NA Esabi +995 322 91 34 71
+36 1 814 8080(General)
+36 1814 8565(For AOC&Philips
Hungary NA Profi Service only)
Kazakhstan NA Classic Service llc. |+7 727 3097515
+371 67460399
Latvia NA ServiceNet LV +371 27260399
Lithuania NA UAB Servicenet I;;g ;ZO%%%?%(O%;EH?&)
Macedonia NA AMC +389 2 3125097
Moldova NA Comel +37322224035
Romania NA Skin +40 21 2101969
Russia NA CPS +7 (495) 645 6746
Serbia&Montenegro | NA Kim Tec d.o.o. +381 11 20 70 684
Slovakia NA Datalan Service +421 2 49207155
Slovenia NA PC H.and +386 1 530 08 24
the republic of Belarus [ NA ServiceBy + 37517 284 0203
Turkey NA Tecpro +90 212 444 4 832
Ukraine NA Topaz +38044 525 64 95
Ukraine NA Comel +380 5627444225

Informazioni di contatto per zona del’AMERICA LATINA:

Paese Call center
Brazil

- Vermont
Argentina

Numero assistenza clienti
0800-7254101

0800 3330 856
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Informazioni di contatto per l'area APMEA:

Paese

Australia

ASP
AGOS NETWORK PTY LTD

Numero assistenza clienti
1300 360 386

Orario d’apertura
Mon.~Fri. 9:00am-5:30pm

New Zealand

Visual Group Ltd.

0800 657447

Mon.~Fri. 8:30am-5:30pm

Hong Kong:

&S Macau:Tel: (853)-0800-987 - R
. Tel: 1 800 425 6396 .
India REDINGTON INDIA LTD SMS: PHILIPS to 56677 Mon.~Fri. 9:00am-5:30pm
+62-21-4080-9086 (Customer _ : An
donesia PT. CORMIC SERVISINDO | Hotline) T3<-386-1T7h§608'304 200;
PERKASA +62—l8888—01 -9086 (Customer Fri. 08:30-11:30; 13:00-17:30
Hotline)
. Mon.~Fri. 9:00am-5:30pm
Korea Alphascan Displays, Inc 1661-5003 Sat. 9:00am-1:00pm
. . Mon.~Fri. 8:15am-5:00pm
Malaysia R-Logic Sdn Bhd +603 5102 3336 Sat. 8:30am-12:30am
Pakistan TVONICS Pakistan +92-213-6030100 Sun.~Thu. 10:00am-6:00pm
Philips Electronics Singapore .
: o Mon.~Fri. 9:00am-6:00pm
Singapore Pte Ltd (Philips Consumer Care | (65) 6882 3966 Sat. 9:00am-1:00pm
Center)
Taiwan FETEC.CO 0800-231-099 Mon.~Fri. 09:00 - 18:00
Thailand AXis Computer System Co. | 05y 934 5498 Mon.~Fri. 8:30am~05:30pm

Ltd.

South Africa

Computer Repair Technologies

011 262 3586

Mon.~Fri. 8:00am~05:00pm

Israel

Eastronics LTD

1-800-567000

Sun.~Thu. 08:00-18:00

FPT Service Informatic

+84 8 38248007 Ho Chi Minh
City

Mon.~Fri. 8:00-12:00, 13:30-

Vietnam Company Ltd. - Ho Chi Minh | +84 5113.562666 Danang City |, ) i

City Branch +84 5113562666 Cantho | |/ ~0>at 8001200
Province

Philippines | = lobal Supply Chain (02) 655-7777; 6359456 Mon.~Fri. 8:30am~5:30pm
Solutions ,Inc.

Armenia

Azerbaijan

Georgia Firebird service centre +97 14 8837911 Sun.~Thu. 09:00 - 18:00

Kyrgyzstan

Tajikistan

Ubekistan | 20riko Plus Private Enterprise | o507 5784450 Mon.~Fri. 09:00 - 18:00

Ltd

Turkmenistan

Technostar Service Centre

+(99312) 460733, 460957

Mon.~Fri. 09:00 - 18:00

Japan

T4 )y TRAE=S—
R— bt s—

0120-060-530

Mon.~Fri. 10:00 - 17:00
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8. Risoluzione dei problemi
e FAQ

8.1 Risoluzione dei problemi

Questa pagina tratta i problemi che possono
essere corretti dall'utente. Se il problema
persiste, dopo avere tentato queste soluzioni,
mettersi in contatto con I'Assistenza Clienti
Philips.

Kl Problemi comuni

Nessuna immagine (il LED d’alimentazione
non ¢ acceso)

* Assicurarsi che il cavo d'alimentazione sia
collegato ad una presa di corrente ed alla
presa sul retro del monitor.

* Per prima cosa, accertarsi che il tasto
d'alimentazione sul pannello frontale
del monitor sia in posizione di OFF
(spegnimento), poi premerlo per metterlo
in posizione ON (d'accensione).

Nessuna immagine (il LED d’alimentazione &
bianco)

* Assicurarsi il computer sia acceso.

* Assicurarsi che il cavo segnale sia collegato

in modo appropriato al computer.

e Assicurarsi che il connettore del cavo del
monitor non abbia pin piegati. In caso
affermativo, sostituire il cavo.

* Potrebbe essere stata attivata la funzione di

risparmio energetico.

Lo schermo visualizza il messaggio

Attention

Check cable connection

e Assicurarsi che il cavo del monitor sia

collegato in modo appropriato al computer.

(Fare anche riferimento alla Guida Rapida)
* Assicurarsi che il connettore del cavo del
monitor non abbia pin piegati.
* Assicurarsi il computer sia acceso.
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Il tasto AUTO non funziona

* La funzione Auto ¢ applicabile solo in
modalita VGA analogico. Se il risuftato non
e soddisfacente, si possono eseguire le
regolazioni manuali usando il menu OSD.

& Nota

La funzione Auto non & applicabile in
modalita DVI digitale perché non € necessaria.

Sono presenti segni visibili di fumo o scintille

*  Non eseguire alcuna delle procedure di
risoluzione dei problemi

* Scollegare immediatamente il monitor dalla
presa di corrente per motivi di sicurezza

»  Chiamare immediatamente un
rappresentante del Centro Assistenza Philips.

Bl Problemi dell'immagine

Limmagine non & centrata

* Regolare la posizione dellimmagine usando
la funzione “Auto” dei controlli OSD.

* Regolare la posizione dellimmagine usando
la voce Phase/Clock (Fase/Clock) del menu
OSD Setup (Impostazione). E valido solo in
modalita VGA.

Limmagine vibra sullo schermo
» Controllare che il cavo segnale sia collegato
in modo appropriato alla scheda video del

Appare uno sfarfallio verticale

* Regolare la posizione dell'immagine usando
la funzione “Auto” dei controlli OSD.

* Eliminare le barre orizzontali usando la
voce Phase/Clock (Fase/Clock) del menu
OSD Setup (Impostazione). E valido solo in
modalita VGA.

Appare uno sfarfallio orizzontale

* Regolare la posizione dellimmagine usando
la funzione “Auto” dei controlli OSD.



* Eliminare le barre orizzontali usando la
voce Phase/Clock (Fase/Clock) del menu
OSD Setup (Impostazione). E valido solo in
modalita VGA.

Limmagine appare sfuocata, indistinta o troppo
scura

* Regolare il contrasto e la luminosita usando
il menu OSD.

Dopo avere spento il monitor, rimane una
"immagine residua", "immagine fantasma" o
"burn-in".

* Lavisualizzazione ininterrotta di immagini
statiche per un lungo periodo di tempo pud
provocare sullo schermo il fenomeno di
“immagine residua” o “immagine fantasma”,
noto anche come “bum-in”. Il "Burn-in", la
"sovrimpressione” o "immagine fantasma"
€ un fenomeno ben noto alla tecnologia
dei pannelli LCD. Nella maggior parte
dei casi il fenomeno "bum-in", "immagine
residua” o "immagine fantasma" scompare
gradatamente nel tempo dopo che il
monitor € stato spento.

* Attivare sempre uno screen saver con
animazione quando si lascia il monitor
inattivo.

» Attivare sempre un'applicazione
d'aggiornamento periodico dello schermo
se il monitor LCD visualizzera contenuti
statici che non cambiano.

* | casi pit gravi di "bum-in" o “immagine
residua” o di “immagine fantasma’’ non
scompaiono e non possono essere risolti.
Tali danni non sono coperti dalla garanzia.

L'immagine appare distorta. Il testo & indistinto
o sfuocato.
* Impostare la risoluzione schermo del
PC sulla stessa risoluzione originale
raccomandata per il monitor.

Sullo schermo appaiono dei punti verdi, rossi,
blu, neri e bianchi

* | punti residui sono una caratteristica
normale dei cristalli liquidi usati dalla
tecnologia moderna. Fare riferimento alla
sezione Criteri di valutazione dei pixel
difettosi per altri dettagli.
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La luce del LED "accensione" & troppo forte e
disturba

* Laluce del LED d'accensione puo essere
regolata usando il menu OSD Setup
(Impostazione).

Per altra assistenza, fare riferimento all’elenco
Centri Informazioni Assistenza Clienti e
rivolgersi ad un rappresentante del Servizio
clienti Philips.

8.2 Domande generiche

Domanda 1: Quando installo il mio monitor,
che cosa devo fare se lo
schermo visualizza il messaggio
"Cannot display this video
mode" (Impossibile visualizzare
questa modalita video)?
Risoluzione raccomandata per
questo monitor: 1920 x 1080 a
60Hz.

*  Scollegare tutti i cavi, poi collegare il PC al
monitor usato in precedenza.

* Aprire il menu Start di Windows e
selezionare Settings (Impostazioni)/Control
Panel (Panello di controllo). Nella finestra
del Control Panel (Pannello di controllo)
selezionare ['icona Display (Schermo). Nella
finestra Proprieta - Schermo, selezionare
la scheda “Settings” (Impostazioni) Nella
scheda Impostazioni, nellarea denominata
“"desktop area” (Risoluzione dello schermo),
spostare il dispositivo di scorrimento su
1920 x 1080 pixel.

Aprire le "Advanced Properties" (Proprieta
Avanzate) ed impostare la Frequenza di
aggiornamento su 60Hz, poi fare clic su OK.

* Riawviare il computer e ripetere le istruzioni
dei punti 2 e 3 per verificare che il PC sia
impostato su 1920 x 1080 a 60Hz.

*  Spegnere il computer, scollegare il vecchio
monitor e ricollegare il monitor LCD Philips.

* Accendere il monitor e poi accendere il PC.

Risposta:

Domanda 2: Qual ¢ la frequenza
d’aggiornamento raccomandata
per il monitor LCD?

Risposta: La frequenza d'aggiornamento

raccomandata per i monitor
LCD e 60Hz. Nel caso ci siano
dei disturbi sullo schermo, la



Domanda 3:

Risposta:

Domanda 4:
Risposta:

Domanda 5:

Risposta:

Domanda 6:

Risposta:

frequenza d'aggiornamento puo
essere regolata su un valore
massimo di 75Hz per cercare di
risolvere il problema.

Che cosa sono i file .inf e

.icm del CD-ROM? Come si
installano i driver (.inf e .icm)?
Questi sono i file driver del
monitor. Seguire le istruzioni
del Manuale d'uso per installare
i driver. La prima volta che si
installa il monitor, il computer
potrebbe richiedere i driver del
monitor (file .inf e .icm ) oppure
il disco del driver. Seguire le
istruzioni per inserire il (CD-
ROM in dotazione) fornito in
dotazione. | driver del monitor
(file .inf e .icm) saranno installati
automaticamente.

Come si regola la risoluzione?
La scheda video / il driver video
ed il monitor determinano
insieme le risoluzioni disponibili.
La risoluzione preferita si
seleziona nel Pannello di
controllo Windows® usando le
"Proprieta - Schermo”.

Che cosa faccio se mi perdo
durante le procedure di
regolazione del monitor?
Premere il tasto OK e poi
selezionare "Reset" (Ripristina)
per richiamare tutte le
impostazioni predefinite.

Lo schermo LCD é resistente
ai graffi?

In generale si raccomanda di
non sottoporre la superficie
del pannello ad impatti e di
proteggerla da oggetti dalla
forma appuntita o arrotondata.
Quando si maneggia il monitor,
assicurarsi di non applicare
pressioni alla superficie del
pannello. Diversamente le
condizioni della garanzia
potrebbero essere modificate.
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Domanda 7:  Come si pulisce la superficie
dello schermo LCD?

Risposta: Usare un panno pulito, morbido
e asciutto per la pulizia normale.
Usare alcool isopropilico per
una pulizia pit accurata. Non
usare altri solventi come alcool
etilico, etanolo, acetone, esano,
eccetera.

Domanda 8: Posso modificare |'impostazione
colore del monitor?

Risposta: S, le impostazioni colore
possono essere modificate
usando, i comandi OSD, come
segue,

*  Premere "OK" per visualizzare il menu OSD
(On Screen Display)

*  Premere la "Down Arrow" (freccia giu)
per selezionare I'opzione "Color" (Colore)
e poi premere il tasto "OK" per accedere
alle impostazioni colore; ci sono tre
impostazioni, come segue.

1. Color Temperature (Temperatura
colore); Le due impostazioni sono:
6500K e 9300K. Con la temperatura
colore 6500K il pannello appare "caldo,
con toni rosso-bianchi”, mentre con la
temperatura colore 9300K il pannello
appare "freddo con toni blu-bianchi".

2. sRGB; & I'impostazione standard
per assicurare il corretto scambio di
colori tra i vari dispositivi (e.g. video/
fotocamere digitali, monitor, stampanti,
scanner, eccetera).

3. Personalizzato; si possono scegliere
le impostazioni preferite del colore
regolando rosso, verde e blu.

& Nota:

Una misurazione del colore della luce irradiato
da un oggetto mentre € riscaldato. Questa
misurazione € espressa in termini di scala
assoluta (gradi Kelvin). Temperature Kelvin
basse, come 2004K sono i rossi; temperature
pit alte - come 9300K - sono i blu. La
temperatura neutra € il bianco, a 6504K.



Domanda 9: Posso collegare il mio monitor
LCD a qualsiasi PC, postazione
di lavoro o Mac!

Risposta: Si. Tutti i monitor LCD Philips
sono compatibili con PC, Mac
e postazioni di lavoro standard.
Potrebbe essere necessario un
cavo adattatore per collegare
il monitor al sistema Mac.
Rivolgersi al rivenditore Philips
per altre informazioni.

Domanda 10: | monitor LCD Philips sono
Plug-and-Play?

Risposta: Si, i monitor sono compatibili
Plug-and-Play con Windows 7/
Windows 8/Vista/XP/NT, Mac
OSX, Linux.

Domanda 11: Che cos’e I'lmage Sticking,
o Image Burn-in, o
sovrimpressione, o immagine
fantasma dei pannelli LCD?

Risposta: La visualizzazione ininterrotta di
immagini statiche per un lungo
periodo di tempo puod provocare
sullo schermo il fenomeno di
“immagine residua” o “immagine
fantasma”, noto anche come
“burn-in". Il "Burmn-in", la
"sovrimpressione" o "immagine
fantasma" € un fenomeno
ben noto alla tecnologia dei
pannelli LCD. Nella maggior
parte dei casi il fenomeno
"burm-in", "immagine residua" o
"immagine fantasma" scompare
gradatamente nel tempo dopo
che il monitor € stato spento.
Attivare sempre uno screen
saver con animazione quando si
lascia il monitor inattivo.
Attivare sempre un'applicazione
d'aggiornamento periodico dello
schermo se il monitor LCD
visualizzera contenuti statici che
non cambiano.

@ Avviso

La mancata attivazione di uno screen saver, o di
una applicazione che aggiorna periodicamente
lo schermo, pud provocare gravi fenomeni di
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“burn-in", o “immagine residua” o “immagine
fantasma’ che non spariranno e che non
potranno essere corretti. | danni di cui sopra
non sono coperti dalla garanzia.

Domanda 12: Perché lo schermo non

Risposta:

visualizza il testo in modo
nitido e mostra dei caratteri
frastagliati?

[l monitor LCD funziona la
meglio con la sua risoluzione
originale di 1920 x 1080 a
60Hz. Usare questa risoluzione
per ottenere la visualizzazione
migliore.
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